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Welcome to Student PACS module creator, an extension for Macromedia Flash.  This program 
runs inside Macromedia Flash to help a user create educational case modules out of radiological 
images.  Let’s go over some critical pointers: 
 
 

 ALWAYS CLICK NO when you are asked if you would like to abort a Javascript.  This is a 
failsafe built into Flash to keep a computer from crashing if a user runs bad Javascript.  Some 
parts of our code are repetitive and take some extra time to run, so Flash can think its bad 
code.  Rest assured though, that we have tested our code enough to know that these error 
messages are insignificant. 

 
 NEVER click outside the panel unless you are asked to do so. (Or unless you know what 

you’re doing within Flash)  This may result in corrupt or non-functioning modules.  Typically, 
Flash will ask you if you would like to “unlock this layer for editing,” whenever this happens.  
CLICK NO! 

 
 ALWAYS use the SPACS menu to open, save, and close StudentPACS .FLA files.  Using 

Macromedia Flash’s buttons will result in loss of your work and possibly corrupt files or 
program crashes.  

 
 
 
Before you begin, you should be familiar with the way a finished teaching module works.  
See some samples on our website: www.studentpacs.com. 
 
 
 
Notice that all StudentPACS commands in this manual look like this, whereas Flash and Windows 
commands look like this.
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Installing the StudentPACS Extension Panel 
 

 Install Adobe/Macromedia Flash Professional, version 8, available at 
www.adobe.com/downloads and most software vendors.  Registration is required to download 
a trial version.  Educational editions of the program can be purchased at significant discounts, 
if you are eligible, through your educational institution or through Adobe itself. 

 
 Download the file StudentPACS102.mxp from www.studentpacs.com.  Double click on the file 

and the Macromedia Extension Manager will appear.  Click Accept and the extension panel 
will install.  Make sure that the extension panel appears as pictured in Figure 1 when 
installation is complete. 

 
Figure 1 

 
 

 Edit your folder options so that Student PACS can work correctly.  Open My Computer from 
your start menu or desktop, click on the Tools menu, and select Folder Options (Figure 2). 
The window in Figure 3 will appear.  Make sure that Hide extensions of known file types is 
UNCHECKED.  Click OK. 

 
Figure 2       Figure 3 
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Setting up your workspace 
 

 To open the StudentPACS extension panel, click Window -> Other Panels -> StudentPACS 
in Flash’s main menu bar.  The Window menu is only visible when a file is open, so the first 
time you open this, you will have to create a new document by clicking Flash Document in the 
“Create New” column of Flash’s intro screen.  You should see a panel with only two buttons, 
New and Open. 

 
 If you leave the StudentPACS panel open, it will stay open the next time you run Flash.  

 
 Maximize your workspace by clicking on the arrows circled in the following picture. 

 

 
 

 Use the scroll bars at the right and bottom of the screen to pan around your image while 
creating modules.  Use Ctrl+ and Ctrl- or View in Flash’s main menu to zoom in or zoom out.  
If an image appears too big to fit on the screen, you need to zoom out. 
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Making a Module (Just a quick overview) 
 
These steps describe the basic flow of creating a module.  If you look at these steps along with the 
next few sections of this manual, you’ll be a pro at this in no time.  
 

 Save your images in a separate directory, make sure they are numbered in the order you 
want them to appear. 

 
 Open Macromedia Flash from the start menu.  Click the New button on the SPACS panel.  

Navigate to a directory you will remember, type a name for the module you are about to make, 
and click OK.  Do not overwrite “template.fla” or you will need to reinstall StudentPACS.  
Don’t name the file after a diagnosis or you will give it away immediately. 

 
 You will be asked for a directory of images.  Navigate to the directory where you saved your 

images and then click OK. 
 

 Click NO if you are asked if you would like to abort the JavaScript. 
 

 Start by clicking Case Info and entering any text that you want to appear in the right panel 
when the case is first opened.  Repeat “A” and “B” below for each finding you want to point out 
in your images.  

 
A. Click New Finding in the middle of the panel, and type a name for whatever you intend to 

label next.  Repeat the following to make clickable “hotspots” for that finding. 
1) Use the Next and Prev buttons at the top to go to the slice that has your finding.  Use 

the scroll bars in Flash and Ctrl+ or Ctrl- on your keyboard to fit your image in 
Flash’s work area. 

2) Click on the Hotspots tab, and then the New/Edit Hotspot button at the bottom right. 
Select the paintbrush tool, select a color and a brush size and then color over the 
entire finding. (Save time by outlining the finding and then using the Paint Bucket Tool) 

3) Click Done on the panel and repeat these three steps until you’ve labeled your finding 
in all of the slices in which it appears.  

B. When you are done, click on the Questions tab and then repeat the following to enter the 
questions you wish to ask when someone clicks on your finding. 
1) Click Add Question. 
2) Type a question, at least one answer choice, and an explanation. 
3) Click on the circle to the left of the correct answer. 
4) Click Apply in the lower left, and repeat these last four steps until you’ve entered all of 

your questions for that finding.  
 

 When you’re finished drawing hotspots and entering questions for each finding, click the 
SPACS Menu button in the upper left and select Save to save your work.  Click the SPACS 
Menu button again and select Publish.   To look at your case, click Control in Flash’s menu 
and then select Test Movie. 
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The StudentPACS Panel Controls (The Details) 
 
 
 
        The StudentPACS extension panel…. 
 
 
 
 
 
 
 
 
 
 
 
 
 
           The bottom of the panel  
                                          after you click the 
                  “Questions” tab. 
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1) SPACS menu:  Use this button to open, close, save, publish, and create new StudentPACS 

modules.   
♦ New, Open, Close, Save, and Save As work like they do any other Windows program 

except that you’ll need to remember to ALWAYS use this button instead of anything 
outside the panel so that you don’t lose your work. 

♦ The Publish command creates two files in the same directory as your “.FLA” file; a “.SWF” 
and a “.HTML” file.  The ”.SWF” file is the published version of your module.  The “.HTML” 
lets you open the module from an internet browser.  Put both of these files on the web or 
on a CD and your module can be viewed by anyone. 

 
2) Edit Case Info:  Use this button to enter general information about your case that you want to 

appear when the module first loads.  (A 50 yo male presents…)   
♦ Tell the user what you want them to do first, whether its searching for a specific finding, or 

just clicking around when they see an abnormality. 
 
3) Next, Prev:  Use these buttons to flip through your images.  At this time, there’s no way to flip 

images with your mouse wheel. 
 
4) Jump:  Enter the number of an image into this box and then press the “Enter” to jump to that 

image. 
 
5) Show All Hotspots:  If an image has multiple hotspots for different findings, you can see all of 

them at once by checking this box. 
 
6) Order Findings:  When this box is checked, Flash will publish your modules so that a user 

must click on your findings in the order that they appear in the Finding Manager.  This is 
essential for “walking” a student through a study.  When unchecked, a user can click on any 
finding in any order. 

 
7) Finding Manager:  Think of “findings” as a group of hotspots and questions. 

A) Add Finding:  This button creates a finding.  You will be prompted for a name.  The name 
is for your purposes only and will not be seen by module users. 

B) Delete Finding:  Use this button to erase a finding and all of its hotspots and questions. 
 
8) Hotspots/Questions list:  This part of the StudentPACS panel displays either the hotspots or 

questions that make up the finding selected in the finding manager depending on whether the 
Hotspots or Questions tabs are selected. 
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9) Hotspots Tab:  This tab lets you highlight structures that make up a finding and turn them into 

“hotspots” which trigger questions to appear when a user clicks on them.  Each finding can 
have multiple hotspots, meaning you can highlight the same structure over multiple frames, 
allowing a user to click anywhere, for instance, on the aorta as it travels through the abdomen.   
1) Add/Edit Hotspot:  Opens the window show below to create a new hotspot, or to edit a 

hotspot selected in the hotspot list. When this window is open, you can use all of the 
drawing tools available in Flash to highlight your findings.  We describe the ones we use 
most below. 

2) Delete Hotspot:  Deletes the hotspot selected in the hotspot list. 

 

10) Questions Tab:  This tab lets you add questions to a finding selected in the “Finding 
Manager”.   These questions display in the right-hand panel .  Like with hotspots, each finding 
can have multiple questions that will display one after the other when a user clicks on a finding. 
♦ IMPORTANT: Each hotspot must have at least one question or you will get an error 

message when you “Publish” your project. 
 
A) Insert Question: Creates a question ABOVE the selected question in the question list. 
B) Add Question:  Creates a question at the end of the question list. 
C) Edit Question: Opens the selected question for editing. 
D) Delete Question: Deletes the selected question.

1) Paintbrush: Your basic tool for 
marking hotspots 

2) Fill: Use this for large hotspots.  
Outline the spot, making sure you 
close the shape, then select this tool 
and click in the middle. 

3) Eraser: Great for editing. 
4) Line Color: Leave this on no color 

(the slashed-out box shown in the 
circle) 

5) Fill Color: Choose a color for your 
hotspots. 

6) Brush Shape: Round usually works 
best. 

7) Brush Size: Stick to thicker sizes 
because small hotspots can be hard 
to click on. 

8) Done: Click here to turn your 
highlighting into a hotspot. 
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Making Better Modules (The Fine Details) 

 Types of Modules:  You can make two types of modules: guided and unguided. In a guided 
case, students look for one finding at a time in the order that you specify.  In an unguided case, 
a student can click on any finding in any order. Technically, the only difference between each 
type of module is whether or not the Order Findings box is checked off, but other things, such 
the way you word your questions, will be significantly different  

♦ If the Order Findings box is NOT checked when you publish the case, students can click 
on any finding in your module in any order.  This would work, for instance if you wanted to 
create a quick case for residents where you wanted to point out only a few findings.  This 
would also work for creating an atlas-like module for anatomy students where everything is 
labeled but very simple, or even blank questions are asked.  (Note that each finding needs 
to have at least one question to work, but the question, its answer choices, or its 
explanation can all be left blank.  In an unguided case, the student would be able to go 
from one hotspot to another without answering the questions) 
• Your case info should end with a vague instruction such as, “See what you can find.”  

You could include a list of findings or some general information about the study but 
there would be no need to point a student towards a specific finding.   

• Your questions and their explanations should refer only to the hotspot that triggers 
them.   

♦ If the Order Findings box IS checked when you publish the case, students must click on 
each finding in the order that is shown in the Finding Manager.  This type of module is 
ideal for teaching a student or resident to look through a study methodically. 
• Your case info should end with a specific instruction to look for the first finding, such as 

“Find the liver.”    
• Your questions should lead the user from one finding to the next.  Each  explanation 

should end with instructions to look for the next finding.   
• The explanation for your last question should say, “THE END.”   

 
 File Types:  StudentPACS is compatible with all images in the JPG, GIF, BMP, PNG, and 

TIFF formats.  If your PACS workstation or reconstruction software is not able to 
export images, consider using a free DICOM reader such as Dicomworks, available at 
www.dicomworks.com, to do the job.
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 File Sizes:  StudentPACS allows up to 100 images with resolutions up to 1920x1200, 
however, this is MUCH bigger than most computers can handle.   

♦ A module created from 100 1024x768 jpgs will take up about 13 megabytes on disk.  A 
module of this size would be the largest we would recommend.  While this size is feasible 
for a user on a fast broadband connection, it might take several minutes to download on 
the congested networks in schools and hospitals.   

♦ Macromedia Flash files, when opened, are far bigger than they are on disk.  The 13 
megabyte module described above would take up about 320 megabytes of RAM, which is 
definitely pushing the envelope if your students will be viewing modules on older school or 
hospital systems.  We don’t recommend exceeding 500 megabytes of RAM usage 

♦ An easy way to check how much memory your module uses is by opening the module in 
an internet browser (use a new browser window and make sure you don't have more than 
one browser window or tab open). Scroll to the last image of the module and then hold 
Ctrl+Alt+Delete to open the Task Manager. Click on the Processes tab and then look for 
your browser, either "Iexplorer.exe" or "Firefox.exe" and follow the row to the right to see 
how much memory is being used. 

♦ Optimize your images by cropping away excess borders and/or resizing very large images.  
This is downright tedious to do for even a few of images, so we recommend using a 
program like Picasa 2, which is a free download from Google to crop or shrink all of your 
images at once. 

♦ Use only every other image, or every 3rd or 4th image for very large studies.  A very quick 
way to do this is to open the folder containing the images in windows.  Select View -> 
Thumbnails.  Resize the window to show 2, 3, or 4 columns if you wish to use every 
other, 3rd, or 4th image, respectively, by dragging the right side of the window.  Select an 
entire column of images by drawing a selection rectangle around it.  Start at the top and 
move the mouse towards the bottom of the window.  The window will automatically scroll 
to the end.  You can hold Ctrl and select multiple columns at once.  Copy these images 
into a different directory for use.   

 Save Time:  Highlighting a finding that appears in many slices of a study is tedious.  A simple 
workaround for this is to ask your question in reference to certain slices of the study.  Eg. “Find 
the aorta in slices 10-15.  The numbers you see in the Image Navigator section of the panel 
correspond to the numbering that appears in the final module.  If your images contained 
numbering when you saved them from your PACS system, you may want to crop the numbers 
out to avoid any confusion.  In general, you should remove all patient info and numbering from 
within your PACS system, as this is easier and faster than cropping them out later.   
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Handy Things to Know About Flash 
 

 When using StudentPACS you will encounter three different file types: 
♦ .FLA – This is file that you work with.  Your projects are saved in this format and these are 

the files that you should open for editing. 
♦ .SWF – This is a flash movie file.  Your modules are published into this format.  You will 

notice that after you publish a module, a .SWF file with the same name as your .FLA file 
will appear in the same directory.  Open this file to view your case.  You cannot edit this 
file. 

♦ .HTML – This is a standard html file that is generated when you publish your module.  It 
tells browsers how to open your .SWF file and checks to see if a student has the correct 
version of Flash installed.  If not, it displays a link for downloading the latest Flash Player. 

 
 To distribute your module for viewing, include both the .SWF and the .HTML file in the SAME 

directory.  Whether you email the files, burn them to CD, or host them on the web, you’ll want 
to include links or instructions for users to open the .HTML file.  

 
 A handy way to preview your module is to select Control -> Test in Flash’s menu, AFTER 

using Publish in the SPACS menu. 
 

 


